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BAB II 

PERANCANGAN BENDUNG 

2.1 Metode Perancangan 

Metode perancangan bendung saat ini terpusat pada aspek hidrologis, 

sementara aspek geoteknik akan diperhitungan dalam bagian yang akan datang. 

Gambar 2.1 merupakan metode perancangan yang digunakan dalam perancangan 

Bendung Gamping. 

 

 
Gambar 2.1 Flowchart Perancangan Bendung Gamping 
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2.2 Bendung 

Bendung merupakan suatu struktur bangunan yang dibangun di atas sungai 

untuk mengatur dan mengendalikan aliran air (Novak et al., 2007). Fungsi utama 

bendung adalah mengendalikan aliran air untuk menghindari banjir, menyediakan 

pasokan air untuk irigasi pertanian, menyediakan air minum, dan sebagainya. 

Bendung terbagi menjadi dua jenis, antara lain: 

1. Bendung Tetap 

Bendung tetap (fixed weir) merupakan jenis bendung yang strukturnya tidak 

dapat diubah dan dibangun secara permanen di atas sungai untuk 

mengendalikan aliran air, sehingga bentuk struktur pengendalian air 

(pembendungnya) dan muka air di hulu bendung tidak dapat diatur sesuai 

yang dikehendaki. 

2. Bendung Gerak 

Bendung gerak (moveable weir) merupakan jenis bendung yang strukturnya 

dapat diubah atau disesuaikan dengan perubahan aliran air, memungkinkan 

penyesuaian bentuk struktur pengendalian air (pembendungnya) dan muka air 

di hulu bendung sesuai yang dikehendaki. 

Berdasarkan jenisnya, Bendung Gamping direncanakan sebagai bendung 

tetap, sehingga bentuk struktur pembendungnya dan elevasi muka air di hulu 

bendung tidak dapat diatur sesuai yang dikehendaki. 

2.3 Lokasi Bendung 

Bendung Gamping terletak di Kecamatan Gamping, Kabupaten Sleman, 

Daerah Istimewa Yogyakarta. Secara geografis, bendung ini dibangun di Sungai 

Bedog dengan koordinat pada 7,792271o LS dan 110,328324o BT. Sungai Bedog 

dan anak sungainya menjadi sungai tinjauan dalam perencanaan pembangunan 

Bendung Gamping. Lokasi bendung dipilih dengan mempertimbangkan topografi 

di sekitar kedua sisi bendung, wilayah irigasi, dan kemudahan akses. Berikut 

merupakan lokasi bendung yang direncanakan yang terlihat pada citra satelit yang 

dapat diakses melalui Google Earth, seperti yang ditunjukkan dalam Gambar 2.2. 
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Gambar 2.2 Lokasi Rencana Bendung Gamping 

 

2.4 Daerah Aliran Sungai (DAS) 

Daerah Aliran Sungai (DAS), juga dikenal sebagai cekungan air atau 

watershed, merupakan wilayah geografis yang dibatasi oleh pegunungan, 

perbukitan, atau punggungan yang berfungsi sebagai tangkapan air alami bagi 

semua air hujan dan air permukaan yang mengalir ke satu sungai utama atau 

cekungan sungai tertentu. 

DAS dapat dibuat melalui berbagai aplikasi, dan salah satunya dengan 

menggunakan QGIS. QGIS (Quantum Geographic Information System) adalah 

sebuah perangkat lunak Sistem Informasi Geografis (SIG) sumber terbuka yang 

dapat digunakan untuk membuat, mengedit, mengelola, serta melakukan analisis 

data geospasial. Berikut merupakan langkah-langkah yang dapat dilakukan dalam 

membuat Daerah Aliran Sungai (DAS) menggunakan QGIS. 

1. Buka Data Source Manager dan masukkan data Digital Elevation Model 

(DEM) dalam format raster. 

2. Jika ada lebih dari satu data DEM, gunakan menu Raster → Miscellaneous 

→ Merge untuk menggabungkannya menjadi satu. 

3. Periksa sistem koordinat pada data DEM di bagian Properties dan pilih 

Source. 

4. Jika sistem koordinat masih menggunakan WGS 84, gunakan menu Raster → 

Projections → Warp (Reproject) untuk mengubahnya menjadi sistem 

koordinat UTM. 
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5. Cari “Fill Sinks (Wang & Liu)” pada pencarian, atur data DEM yang akan 

diproses, dan jalankan prosesnya. 

6. Selanjutnya, cari “Strahler Order” dalam pencarian, pilih data yang telah diisi 

sebelumnya, dan jalankan (Strahler Order bertujuan untuk mengidentifikasi 

jaringan sungai). 

7. Gunakan menu Raster → Raster Calculator untuk mempermudah visualisasi 

jaringan sungai. 

8. Untuk menampilkan DAS dari jaringan sungai yang telah dibuat, pilih titik 

area yang akan dijadikan titik akhir DAS dan catat koordinatnya. 

9. Cari “Upslope Area” dalam pencarian, masukkan koordinat titik yang telah 

ditentukan, dan jalankan program hingga DAS muncul sebagai data raster. 

10. Konversi data DAS dari format raster ke format vektor dengan menu Raster 

→ Conversion → Polygonise. 

11. Untuk menampilkan luas DAS, klik kanan pada layer vektor DAS → Open 

Attribute Table → New Field untuk menambahkan luas DAS. 

Dalam perencanaan bendung di Sungai Bedog, Kecamatan Gamping, 

Kabupaten Sleman, Daerah Istimewa Yogyakarta, diperlukan identifikasi awal 

terhadap data Daerah Aliran Sungai (DAS) sebagai dasar perencanaan. Dalam hal 

ini, perlu dianalisis debit aliran sungai yang berasal dari DAS Bedog yang 

mencerminkan tangkapan air hujan yang akan mengalir ke dalam sungai di wilayah 

DAS Bedog, yang selanjutnya akan menuju bendung. Gambar 2.3 merupakan 

Daerah Aliran Sungai (DAS) Bedog dengan penempatan titik stasiun hujan yang 

akan menjadi titik acuan awal untuk analisis hidrologi. 
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Gambar 2.3 Daerah Aliran Sungai (DAS) Bedog 

 

2.5 Stasiun Curah Hujan 

Stasiun curah hujan merupakan sebuah perangkat yang digunakan untuk 

mengukur intensitas hujan pada suatu daerah dengan cara mendeteksi dan 

mengukur jumlah air hujan yang jatuh ke permukaan tanah dalam satuan tertentu, 

seperti milimeter atau inci. Biasanya, stasiun curah hujan dilengkapi dengan wadah 

penampung hujan yang dirancang untuk mengumpulkan air hujan. Setelah air hujan 

terkumpul dalam wadah tersebut, stasiun ini menggunakan sensor atau mekanisme 

khusus untuk mengukur volume atau tingkat air hujan yang terkumpul di dalam 

wadah tersebut. 

Setelah mendapatkan Daerah Aliran Sungai (DAS) Bedog, langkah 

berikutnya adalah membagi DAS tersebut menjadi beberapa wilayah berdasarkan 

stasiun curah hujan yang menggunakan metode Polygon Thiessen. Metode Polygon 

Thiessen, yang juga dikenal sebagai Voronoi Polygon, merupakan konsep dalam 

analisis spasial yang digunakan untuk mempartisi suatu daerah menjadi beberapa 

wilayah terpisah berdasarkan letak titik-titik tertentu. Berikut merupakan langkah-

langkah yang dapat dilakukan untuk membagi wilayah tiap stasiun curah hujan 

menggunakan metode Polygon Thiessen dalam QGIS. 

1. Masukkan koordinat data stasiun curah hujan dari file Excel. 

2. Buka menu Vector → Geometry Tools → Voronoi Polygons. Pilih data stasiun 

curah hujan untuk melihat area setiap stasiun curah hujan. 
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3. Untuk membuat area setiap stasiun curah hujan terlihat di dalam wilayah 

Daerah Aliran Sungai (DAS), buka menu Vector → Geoprocessing Tools → 

Clip. Pilih wilayah DAS yang akan di-clip dengan area stasiun curah hujan, 

lalu jalankan proses ini. 

4. Selanjutnya, simpan hasilnya sebagai file SHP. Klik kanan pada layer clip 

yang telah dibuat, pilih Export → Save Features As → atur format penamaan, 

sistem koordinat, dan jenis file ke format SHP → OK. 

5. Untuk melengkapi data yang terkait dengan stasiun curah hujan, buka menu 

Open Attribute Table dan pilih New Field. 

Dalam perencanaan Bendung Gamping, data curah hujan yang digunakan 

berasal dari tujuh stasiun curah hujan, yaitu Plambongan, Kemput, Angin-Angin, 

Prumpung, Seyegan, Beran, dan Godean, dengan rentang waktu dari tahun 1984 

hingga tahun 1993. Dari ketujuh stasiun tersebut, hanya enam di antaranya yang 

dapat digunakan dalam metode Polygon Thiessen, yaitu Kemput, Angin-Angin, 

Prumpung, Seyegan, Beran, dan Godean, karena letak geografis keenam stasiun 

tersebut mencakup daerah dari hulu Merapi hingga lokasi bendung. Data yang 

digunakan untuk perhitungan adalah curah hujan tertinggi dan yang memiliki 

catatan data yang lengkap selama periode 10 tahun tersebut. Berikut merupakan 

pembagian luas area dalam Daerah Aliran Sungai (DAS) Bedog, yang dapat dilihat 

dalam Tabel 2.1. 

Tabel 2.1 Pembagian Luas Area DAS Bedog 

Pembagian Luas Area DAS Bedog 

Daerah 
Luas Persentase Luasan 

Ha km2 (%) 

Sta. Godean 310,223 3,102 4,93 

Sta. Seyegan 173,294 1,733 2,75 

Sta. Prumpung 31,267 0,313 0,50 

Sta. Kemput 2.127,896 21,279 33,79 

Sta. Angin-Angin 2.182,310 21,823 34,65 

Sta. Beran 1.472,808 14,728 23,39 

Total Area 6.297,799 62,978 100,00 
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2.6 Analisis Data Hujan 

Setelah memperoleh data lengkap dari stasiun curah hujan yang telah 

ditentukan selama 10 tahun, curah hujan rerata dapat dihitung. Berikut merupakan 

persamaan (2.1) yang digunakan untuk menghitung curah hujan rerata sesuai 

dengan metode yang dijelaskan oleh Triatmodjo (2008). 

    x̅ = ∑
ri ai

A

n
i = 1          (2.1) 

dimana : x̅ = nilai curah hujan rerata (mm) 

   ri = nilai curah hujan pada stasiun i (mm) 

   ai = luas sub-DAS/poligon pada stasiun i (km2) 

  A  = total luas DAS (km2) 

Dalam perencanaan Bendung Gamping, digunakan data curah hujan dari 

enam stasiun curah hujan selama 10 tahun, dimulai dari tahun 1984 hingga tahun 

1993. Untuk menghitung curah hujan rerata, digunakan metode Polygon Thiessen, 

karena DAS Bedog termasuk dalam kategori sedang. Hasil curah hujan rerata 

mencerminkan gambaran keseluruhan curah hujan di DAS Bedog. Fokus utama 

dalam perencanaan bendung ini adalah nilai maksimum curah hujan rerata di DAS 

Bedog tersebut. Nilai ini sangat penting karena digunakan sebagai panduan untuk 

menentukan kapasitas dan dimensi bendung yang akan dibangun. Hal ini bertujuan 

untuk mencegah limpasan berlebihan dan memastikan efektivitas serta efisiensi dari 

dimensi bendung yang direncanakan. Data curah hujan rerata maksimum DAS 

Bedog dari tahun 1984 hingga tahun 1993 termuat dalam Tabel 2.2. 

Tabel 2.2 Curah Hujan Harian Maks. Rerata DAS Bedog Selama 10 Tahun 

Tahun Curah Hujan Harian Maksimum Rerata (mm) 

1984 92,216 

1985 51,677 

1986 45,125 

1987 49,322 

1988 65,135 

1989 71,858 

1990 47,820 

1991 68,306 

1992 70,767 
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 Lanjutan Tabel 2.2 Curah Hujan Harian Maks. Rerata DAS Bedog Selama 10 Tahun 

Tahun Curah Hujan Harian Maksimum Rerata (mm) 

1993 43,814 

Total 606,041 

Rerata 60,604 
 

 

2.7 Analisis Statistik dan Frekuensi 

Analisis frekuensi hidrologi merupkan sebuah pendekatan yang digunakan 

untuk mengkaji dan memahami pola serta karakteristik sebaran frekuensi kejadian 

hidrologi dalam suatu periode waktu tertentu. Berikut merupakan langkah-langkah 

dan persamaannya yang dapat digunakan untuk perhitungan dan analisis frekuensi 

curah hujan. 

1. Menentukan nilai curah hujan harian maksimum rerata per tahun dengan 

melakukan perhitungan curah hujan harian maksimum dari semua stasiun 

curah hujan yang telah ditentukan sebelumnya. 

2. Rerata dari sepuluh nilai curah hujan harian maksimum, dihitung dengan 

persamaan (2.2) : 

    x̅ = 
∑ xi

n
        (2.2) 

dimana : x̅  = nilai curah hujan rerata (mm) 

xi = nilai curah hujan ke-i (mm) 

n   = jumlah curah hujan 

3. Standar deviasi, yang sering disebut sebagai simpangan baku, merupakan 

ukuran sebaran data dalam sampel yang digunakan untuk mengevaluasi 

sejauh mana nilai-nilai data mendekati atau menjauhi nilai rata-ratanya. Nilai 

standar deviasi, dihitung dengan persamaan (2.3): 

Sd = √
∑ (xi - x̅)

2n
i=1

n - 1
       (2.3) 

dimana : Sd = nilai standar deviasi curah hujan 

x̅   = nilai curah hujan rerata (mm) 

xi = nilai curah hujan ke-i (mm) 

n   = jumlah curah hujan 
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4. Nilai koefisien variasi (Cv), merupakan nilai yang diperoleh dari 

perbandingan antara standar deviasi dengan curah hujan rerata, dihitung 

dengan persamaan (2.4): 

Cv = 
Sd

x̅
        (2.4) 

5. Nilai koefisien kemencengan/Skewness (Cs), merupakan derajat 

kemencengan dari suatu bentuk distribusi, dihitung dengan persamaan (2.5):  

        Cs = 
n ∑ (xi - x̅)

3n
i=1

(n - 1) (n - 2) Sd
3                             (2.5) 

6. Nilai kurtosis (Ck), merupakan nilai keruncingan kurva distribusi yang 

biasanya dibandingkan dengan distribusi normal, dihitung dengan persamaan 

(2.6): 

       Ck = 

1

n
 ∑ (xi - x̅)

4

Sd
4                               (2.6) 

Tabel 2.3 menunjukkan hasil perhitungan analisis frekuensi dari data curah 

hujan maksimum rerata yang telah ditentukan sebelumnya. 

Tabel 2.3 Analisis Frekuensi Hidrologi 

No xi x̅ xi - x̅ (xi - x̅)2 (xi - x̅)3 (xi - x̅)4 

1 43,814 60,604 -16,790 281,899 -4733,036 79466,926 

2 45,125 60,604 -15,479 239,606 -3708,919 57411,168 

3 47,820 60,604 -12,784 163,430 -2089,292 26709,477 

4 49,322 60,604 -11,282 127,277 -1435,897 16199,352 

5 51,677 60,604 -8,927 79,685 -711,323 6349,732 

6 65,135 60,604 4,530 20,525 92,989 421,287 

7 68,306 60,604 7,702 59,326 456,946 3519,544 

8 70,767 60,604 10,163 103,289 1049,736 10668,584 

9 71,858 60,604 11,254 126,651 1425,318 16040,421 

10 92,216 60,604 31,612 999,291 31589,153 998582,555 

∑ 2200,979 21935,677 1215369,046 

Standar Deviasi: 

Sd = √
2200,979

10 - 1
 = 15,638 
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Koefisien Variasi (Cv): 

Cv = 
15,638

60,604
 = 0,258 

Koefisien Skewness (Cs): 

Cs = 
10 × 21935,677

(10 - 1) (10 - 2) 15,638
3

 = 0,797 

Koefisien Kurtosis (Ck): 

Ck =

1
10

 × 1215369,046

15,6384
 = 2,032 

2.8 Tipe Distribusi 

Distribusi data merupakan metode dalam menentukan sebaran yang akan 

terdistribusi. Distribusi data ini membantu dalam menghitung curah hujan 

rancangan berdasarkan data curah hujan harian maksimum yang telah diperoleh. 

Beberapa tipe distribusi yang umum digunakan adalah distribusi Normal, Log 

Normal, Gumbel Tipe I, dan Log Pearson Tipe III. Setelah melakukan perhitungan 

terhadap beberapa parameter dalam analisis frekuensi, hasil dari parameter tersebut 

dibandingkan dengan persyaratan tipe distribusi yang sesuai, seperti yang 

tercantum dalam Tabel 2.4 di bawah ini. 

Tabel 2.4 Syarat Tipe Distribusi 

No Tipe Distribusi Syarat 
Hasil 

Perhitungan 

1 Gumbel Tipe I 
Cs ≈ 1,14 0,797 ≈ 1,14 

Ck ≈ 5,4 2,032 ≈ 5,4 

2 Log Normal 

Cs = Cv3 + 3Cv 0,797 ≠ 0,791 

Ck = Cv8 + 6Cv6 + 15Cv4 + 

16Cv2 + 3 
2,032 ≠ 4,134 

3 Log Pearson Tipe III selain tipe lainnya 

4 Normal 
Cs ≈ 0 0,797 ≈ 0 

Ck ≈ 3 2,032 ≈ 3 
 

Berdasarkan hasil perhitungan, dapat disimpulkan bahwa data yang telah 

diolah tidak memenuhi syarat apa pun, sehingga jenis distribusinya dapat 
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dinyatakan sebagai Log Pearson Tipe III. Dalam Tabel 2.5 di bawah ini terdapat 

hasil perhitungan analisis distribusi menggunakan Log Pearson Tipe III. 

Tabel 2.5 Analisis Distribusi Log Pearson Tipe III 

No xi 
Log 

x̅ 

Log xi – 

Log x̅ 

(Log xi - Log 

x̅)2 

(Log xi – Log 

x̅)3 

(Log xi – Log 

x̅)4 

1 43,814 1,770 -0,129 0,0165 -0,0021 0,0003 

2 45,125 1,770 -0,116 0,0134 -0,0015 0,0002 

3 47,820 1,770 -0,091 0,0082 -0,0007 0,0001 

4 49,322 1,770 -0,077 0,0059 0,0005 0,0000 

5 51,677 1,770 -0,057 0,0032 0,0002 0,0000 

6 65,135 1,770 0,044 0,0019 0,0001 0,0000 

7 68,306 1,770 0,064 0,0041 0,0003 0,0000 

8 70,767 1,770 0,080 0,0064 0,0005 0,0000 

9 71,858 1,770 0,086 0,0075 0,0006 0,0001 

10 92,216 1,770 0,195 0,0379 0,0074 0,0014 

∑ 0,1050 0,0038 0,0021 
 

Standar Deviasi: 

Sd = √
0,1050

10 - 1
 = 0,108 

Koefisien Variasi (Cv): 

Cv = 
0,108

1,770
 = 0,061 

Koefisien Skewness (Cs): 

Cs = 
10 × 0,0038

(10 - 1) (10 - 2) 0,108
3

 = 0,421 

Koefisien Kurtosis (Ck): 

Ck =

1
10

 × 0,0021

0,108
4

 = 1,555 

2.9 Uji Sebaran Data Curah Hujan 

Uji sebaran data curah hujan merupakan serangkaian teknik statistik yang 

digunakan untuk menganalisis dan menguji pola sebaran data curah hujan. Tujuan 

dari uji sebaran ini adalah untuk memeriksa apakah data yang tersedia memiliki 

distribusi yang representatif dan memadai untuk mewakili data curah hujan secara 

keseluruhan yang digunakan dalam perencanaan bendung. Uji sebaran data curah 
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hujan yang dilakukan ini meliputi dua pengujian, yaitu uji Chi-Kuadrat (Chi-

Square) dan uji Smirnov-Kolmogorov. 

2.9.1 Uji Chi-Kuadrat (Chi-Square) 

Uji Chi-Kuadrat merupakan metode statistik yang digunakan untuk 

menentukan apakah ada hubungan antara dua variabel atau apakah distribusi 

frekuensi dari kedua variabel tersebut berbeda atau sama secara signifikan. Hasil 

dari uji ini adalah nilai Chi-Kuadrat (X2) yang dibandingkan dengan nilai kritis 

dalam tabel Chi-Kuadrat. Jika X2 melebihi nilai kritis, maka terdapat hubungan atau 

perbedaan yang signifikan antara variabel-variabel yang diuji. Pengambilan 

keputusan menggunakan uji Chi-Kuadrat, dihitung dengan persamaan (2.7): 

X2 = ∑
(Of - Ef)

2

Ef

G
i = 1                                          (2.7) 

dimana : X2 = nilai Chi-Kuadrat 

G   = jumlah sub-kelompok 

Of  = jumlah nilai pengujian pada sub-kelompok ke-1 

Ef  = jumlah nilai teoritis pada sub-kelompok ke-1 

Dalam Tabel 2.6 dan Tabel 2.7 di bawah ini terdapat hasil perhitungan uji Chi-

Kuadrat dari data curah hujan. 

Tabel 2.6 Uji Chi-Kuadrat 

xmax 92,216 

xmin 43,814 

Jumlah Data (n) 10 

Jumlah Kelas (K) 1 + 3,322 Log (n) 4,322 ≈ 4 

Derajat Bebas (V) K – 1 – h 2 

Α 0,05 ≈ 5% 

Dari Tabel Chi-Kuadrat, diperoleh harga xteori
2  18,447 

Jumlah Frekuensi (Ef) 
n

K
 2,5 

Dx 
xmax - xmin

K - 1
 16,134 

xawal xmin – (0,5Dx) 35,747 
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Tabel 2.7 Perhitungan Uji Chi-Kuadrat 

No. Interval Kelas Ef Of 
(𝐄𝐟 − 𝐎𝐟)𝟐

𝐄𝐟
 

1 43,814 - 55,915 2,5 5 2,5 

2 55,915 - 68,015 2,5 1 0,9 

3 68,015 - 80,115 2,5 3 0,1 

4 80,115 - 92,216 2,5 1 0,9 

xhitung
2  4,4 

 

Berdasarkan hasil perhitungan, dapat disimpulkan bahwa nilai  

xhitung
2  = 4,4 < xteori

2  = 18,447, sehingga uji sebaran data curah hujan yang ada 

tersebut memenuhi syarat uji Chi-Kuadrat. 

2.9.2 Uji Smirnov-Kolmogorov 

Uji Smirnov-Kolmogorov merupakan metode statistik yang digunakan untuk 

menentukan sejauh mana kesesuaian data yang diamati dengan distribusi yang 

diharapkan. Uji ini menghasilkan nilai statistik D, yang mencerminkan perbedaan 

maksimum antara dua fungsi distribusi. Nilai D tersebut kemudian digunakan 

dalam perhitungan nilai p untuk mengambil keputusan statistik. Berikut merupakan 

langkah-langkah dan persamaannya yang dapat digunakan dalam uji Smirnov-

Kolmogorov. 

1. Susun data dari nilai yang terbesar sampai nilai yang terkecil, kemudian nilai 

P(X) dan P(Xn) dihitung dengan persamaan (2.8) dan persamaan (2.9): 

P(X) = 
m

n + 1
                   (2.8) 

P(Xn) = 1 – P(X)                  (2.9) 

dimana : m = nomor urut dua 

n  = jumlah data 

2. Nilai P’(X) dan P’(Xn), dihitung dengan persamaan (2.10) dan persamaan 

(2.11): 

           P’(X) = 
m

n - 1
      (2.10) 

      P’(Xn) = 1 – P’(X)      (2.11) 

3. Nilai Dmax, dihitung dengan persamaan (2.12): 

   Dmax = P(Xn) – P’(Xn)     (2.12) 

 

 



17 

 
 

Selanjutnya, interval deviasi maksimum (Dmax) dibandingkan dengan nilai 

kritis. Jika Dmax lebih kecil daripada nilai kritis, maka hipotesis diterima. 

Berikut merupakan nilai-nilai kritis yang digunakan dalam uji Smirnov-

Kolmogorov, beserta dengan tahapan perhitungan uji Smirnov-Kolmogorov yang 

dapat ditemukan dalam Tabel 2.8 dan Tabel 2.9. 

Tabel 2.8 Nilai Kritis (Derajat Kepercayaan/α) 

N 
Derajat Kepercayaan (α) 

0,20 0,10 0,05 0,01 

5 0,45 0,51 0,56 0,67 

10 0,32 0,37 0,41 0,49 

15 0,27 0,30 0,34 0,40 

25 0,21 0,24 0,27 0,32 

30 0,19 0,22 0,24 0,29 

40 0,17 0,19 0,21 0,25 

45 0,16 0,18 0,20 0,24 

50 0,15 0,17 0,19 0,23 

N > 50 
1,07

N0,5
 

1,22

N0,5
 

1,36

N0,5
 

1,63

N0,5
 

 

Tabel 2.9 Nilai Dmax 

Tahun m 𝐱𝐢 

P(X) P(X<) P’(X) P’(X<) Dmax 

m

n + 1
 1 – P(X) 

m

n - 1
 1 – P’(X) 

P(X<) – 

P’(X<) 

1984 1 43,814 0,091 0,909 0,111 0,889 0,020 

1985 2 45,125 0,182 0,818 0,222 0,778 0,040 

1986 3 47,820 0,273 0,727 0,333 0,667 0,061 

1987 4 49,322 0,364 0,636 0,444 0,556 0,081 

1988 5 51,677 0,455 0,545 0,556 0,444 0,101 

1989 6 65,135 0,545 0,455 0,667 0,333 0,121 

1990 7 68,306 0,636 0,364 0,778 0,222 0,141 

1991 8 70,767 0,727 0,273 0,889 0,111 0,162 

1992 9 71,858 0,818 0,182 1,000 0,000 0,182 

1993 10 92,216 0,909 0,091 1,111 -0,111 0,202 
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Berdasarkan hasil perhitungan, dapat disimpulkan bahwa nilai  

Dmax = 0,202 < Dkritis = 0,410, sehingga uji sebaran data curah hujan yang ada 

dapat diterima. 

2.10 Periode Ulang Tahunan 

Periode ulang tahunan merupakan periode waktu rata-rata di antara dua 

kejadian hujan dengan intensitas atau volume tertentu yang sama. Periode ulang 

tahunan digunakan untuk mengukur frekuensi dan intensitas banjir atau hujan yang 

berpotensi mengancam struktur bendung atau sistem pengendalian banjir. 

Perhitungan periode ulang tahunan melibatkan penggunaan data analisis frekuensi 

distribusi yang memenuhi persyaratan tertentu. Oleh karena itu, parameter yang 

digunakan dalam perhitungan ini diperoleh dari hasil distribusi Log Pearson Tipe 

III. Nilai G diperoleh dari hasil interpolasi nilai G berdasarkan Cs dan periode ulang 

Log Pearson Tipe III pada Tabel 2.10. 

Tabel 2.10 Nilai G Berdasarkan Cs dan Periode Ulang 

Kemencengan 

(Cs) 

Periode Ulang (Tahun) 

2 5 10 25 50 100 200 1000 

Peluang (%) 

50 20 10 4 2 1 0,5 0,1 

3,000 -0,360 0,420 1,180 2,278 3,152 4,051 4,970 7,250 

2,500 -0,360 0,518 1,250 2,262 3,048 3,845 4,652 6,600 

2,200 -0,330 0,574 1,284 2,240 2,970 3,705 4,444 6,200 

2,000 -0,307 0,609 1,302 2,219 2,912 3,605 4,298 5,910 

1,800 -0,181 0,643 1,318 2,193 2,848 3,499 4,147 5,660 

1,600 -0,254 0,675 1,329 2,163 2,780 3,388 3,990 5,390 

1,400 -0,225 0,705 1,337 2,128 2,706 3,271 3,828 5,110 

1,200 -0,195 0,732 1,340 2,087 2,626 3,149 3,661 4,820 

1,000 -0,164 0,758 1,340 2,043 2,542 3,022 3,489 4,540 

0,900 -0,148 0,769 1,339 2,018 2,498 2,957 3,401 4,395 

0,800 -0,132 0,769 1,336 1,998 2,453 2,891 3,312 4,250 

0,700 -0,116 0,780 1,333 1,967 2,407 2,824 3,223 4,105 

0,600 0,099 0,800 1,328 1,939 2,359 2,755 3,132 3,960 

0,500 -0,083 0,808 1,323 1,910 2,311 2,686 3,041 3,815 
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Lanjutan Tabel 2.10 Nilai G Berdasarkan Cs dan Periode Ulang 

Kemencengan 

(Cs) 

Periode Ulang (Tahun) 

2 5 10 25 50 100 200 1000 

Peluang (%) 

50 20 10 4 2 1 0,5 0,1 

0,400 -0,066 0,816 1,317 1,880 2,261 2,615 2,949 3,670 

0,300 -0,050 0,824 1,309 1,849 2,211 2,544 2,856 3,525 

0,200 -0,033 0,830 1,301 1,818 2,159 2,472 2,763 3,380 

0,100 -0,017 0,836 1,292 1,785 2,107 2,400 2,670 3,235 

0,000 0,000 0,842 1,282 1,751 2,054 2,326 2,576 3,090 

-0,100 0,017 0,836 1,270 1,761 2,000 2,252 2,282 2,950 

-0,200 0,033 0,850 1,258 1,680 1,945 2,178 2,388 2,810 

-0,300 0,050 0,853 1,245 1,643 1,890 2,104 2,289 2,675 

-0,400 0,066 0,855 1,231 1,606 1,834 2,029 2,201 2,540 

-0,500 0,083 0,856 1,216 1,567 1,777 1,955 2,108 2,400 

-0,600 0,099 0,857 1,200 1,528 1,720 1,880 2,016 2,275 

-0,700 0,116 0,857 1,183 1,488 1,663 1,806 1,926 2,150 

-0,800 0,132 0,856 1,166 1,448 1,606 1,733 1,837 2,035 

-0,900 0,148 0,854 1,147 1,407 1,549 1,660 1,749 1,971 

-1,000 0,164 0,852 1,128 1,366 1,492 1,588 1,664 1,800 

-1,200 0,195 0,844 1,086 1,282 1,379 1,449 1,501 1,625 

-1,400 0,225 0,832 1,041 1,198 1,270 1,318 1,351 1,465 

-1,600 0,254 0,817 0,994 1,116 1,166 1,197 1,216 1,280 

-1,800 0,282 0,799 0,945 1,035 1,069 1,087 1,097 1,130 

-2,000 0,307 0,777 0,895 0,959 0,980 0,990 0,995 1,000 

-2,200 0,330 0,752 0,844 0,888 0,900 0,905 0,907 0,910 

-2,500 0,360 0,711 0,771 0,793 0,798 0,799 0,800 0,802 

-3,000 0,396 0,636 0,660 0,666 0,666 0,667 0,667 0,668 
 

Setelah mendapatkan nilai G, langkah berikutnya adalah menghitung nilai X 

menggunakan persamaan Log X = Log X̅ + G × Sd. Nilai ini akan digunakan dalam 

perhitungan debit banjir dan debit andalan. Berikut merupakan perhitungan untuk 

periode ulang 50 tahun. 
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Log X50 = Log (1,770) + 2,271 × 0,108 

        X50 = 103,636 mm 

Dengan langkah yang sama, berikut ini merupakan rekapan perhitungan untuk 

periode ulang 5, 10, 20, 25, 50, dan 100 tahun yang tercantum dalam Tabel 2.11. 

Tabel 2.11 Periode Ulang Tahun 

Periode 

Ulang 

(Tahun) 

Kemencengan 

(Cs) 

Standar 

Deviasi 

(Sd) 

Log 

X̅ 
G 

Log 

X 

X 

(mm) 

5 0,421 0,108 1,770 0,814 1,858 72,128 

10 0,421 0,108 1,770 1,318 1,913 81,760 

20 0,421 0,108 1,770 1,697 1,953 89,835 

25 0,421 0,108 1,770 1,886 1,974 94,167 

50 0,421 0,108 1,770 2,271 2,016 103,636 

100 0,421 0,108 1,770 2,630 2,054 113,298 
  

2.11 Kebutuhan Debit Irigasi 

Kebutuhan debit irigasi merupakan jumlah air yang harus disalurkan ke lahan 

pertanian melalui sistem irigasi untuk memenuhi kebutuhan air tanaman dan 

mendukung pertumbuhan tanaman yang optimal. Kebutuhan air terbagi menjadi 

dua jenis, yaitu kebutuhan air tanaman dan kebutuhan air irigasi. 

2.11.1 Kebutuhan Air Tanaman (Evapotranspirasi Tanaman) 

Kebutuhan air tanaman merupakan jumlah total air yang dibutuhkan selama 

siklus pertumbuhannya, termasuk evaporasi dari tanah dan air yang digunakan 

selama transpirasi. Pengukuran ini penting untuk mengatur irigasi agar tanaman 

tumbuh dengan baik dan hasil panennya maksimal. 

Evapotranspirasi merupakan proses gabungan pelepasan uap air ke atmosfer 

melalui proses evaporasi dan transpirasi. Evaporasi (penguapan) merupakan proses 

perubahan cairan menjadi (uap air) yang berasal dari permukaan air bebas, terjadi 

siang dan malam. Transpirasi (pemeluhan) merupakan proses pelepasan uap air 

melalui stomata daun saat fotosintesis, dengan air berasal dari dalam tanah dan terjadi 

terutama pada siang hari. Jumlah evapotranspirasi dihitung dengan menggunakan 

hasil pengembangan dari Nedesco/Prosida dengan metode Penman Modifikasi. 

Dalam perhitungannya, rumus teoritis empiris dipergunakan, yang mana 
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mempertimbangkan data curah hujan dan data klimatologi. Data curah hujan berupa 

data sekunder, sedangkan data klimatologi berupa letak lintang (LL), suhu udara (t), 

kecerahan matahari (n/N), kecepatan angin (U), dan kelembaban relatif (Rh). 

Parameter evapotranspirasi dapat dilihat di Lampiran 3. 

2.11.2 Kebutuhan Air Irigasi (Pola Tata Tanam) 

Kebutuhan air irigasi merupakan jumlah air tambahan yang dibutuhkan untuk 

menyediakan pasokan air yang memadai kepada tanaman di lahan pertanian, 

terutama saat kondisi cuaca atau curah hujan tidak mencukupi untuk mendukung 

pertumbuhan tanaman dengan baik. Kebutuhan air irigasi bertujuan untuk 

merencanakan pola tata tanam yang dapat mengefisiensikan penggunaan saluran 

irigasi sehingga jaringan irigasi dapat disuplai dengan cukup air sesuai 

kebutuhannya. Penentuan kebutuhan air irigasi ini dilatarbelakangi oleh kehilangan 

air dan energi yang terjadi dalam sistem saluran irigasi, mulai dari pintu air bendung 

hingga mencapai lahan pertanian. Kehilangan air ini dapat disebabkan oleh 

penyerapan (absorpsi) air oleh tanah, penguapan akibat sinar matahari, kebocoran 

dalam saluran, dan sebagainya. 

Selain evapotranspirasi, ada kebutuhan lain yang harus dipenuhi untuk 

memenuhi kebutuhan air irigasi, yaitu: 

1. Curah Hujan Efektif (Re) 

Curah hujan efektif merupakan curah hujan yang jatuh selama masa tumbuh 

tanaman, yang dapat digunakan untuk memenuhi air konsumtif tanaman. 

Besarnya curah hujan ditentukan dengan 80% dari curah hujan rerata tengah 

bulanan dengan kemungkinan kegagalan 20% (curah hujan R80). Curah hujan 

efektif, dihitung dengan persamaan (2.13): 

Re = 0,7 × 
1

15
 R80                           (2.13) 

dimana : Re  = curah hujan efektif (mm/hari) 

R80 = curah hujan minimum tengah bulanan dengan kemungkinan 

terpenuhi 80% 

15  = jumlah hari setenagh bulan 

2. Koefisien Tanaman (Kc) 

Koefisien tanaman merupakan angka yang digunakan dalam perhitungan 

evapotranspirasi untuk menggambarkan seberapa banyak air yang digunakan 
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oleh tanaman selama fase pertumbuhan. Koefisien tanaman ini diperoleh dari 

FAO dan Nedesco/Prosida (Dirjen Pengairan, Bina Program PSA 020, 1985). 

3. Perkolasi (P) 

Perkolasi dipengaruhi oleh tekstur tanah, permeabilitas tanah, dan tebal 

lapisan tanah bagian atas. Untuk Daerah Istimewa Yogyakarta digunakan nilai 

perkolasi sebesar 2,0 mm/hari. 

4. Penyiapan Lahan (PL) 

Faktor-faktor yang menentukan kebutuhan penyiapan lahan adalah lamanya 

waktu yang dibutuhkan untuk menyelesaikan pekerjaan tersebut dan jumlah 

air yang diperlukan. Untuk seluruh petak lahan tersier, disarankan untuk 

menyelesaikan penyiapan lahan dalam waktu 1,5 bulan (45 hari). Kebutuhan 

air untuk proses pengolahan lahan (puddling) dapat diambil sebesar 200 mm 

untuk mencapai tingkat penjenuhan (presaturation). Selain itu, saat awal 

transplantasi, diperlukan tambahan lapisan air sebesar 50 mm. Angka 200 mm 

ini diasumsikan tanah tidak ditanami selama lebih dari 2,5 bulan. Namun, jika 

tanah dibiarkan lebih lama, maka perlu menambahkan 250 mm lagi sebagai 

kebutuhan air untuk penyiapan lahan. 

5. Pergantian Lapisan Air (WLR) 

Water layer replacement (WLR) merupakan tindakan penggantian air yang 

ada di lahan sawah dengan air irigasi yang baru dan segar. Proses penggantian 

lapisan air ini dilakukan setelah pemupukan dan disesuaikan dengan 

kebutuhan. Biasanya, penggantian lapisan air dilakukan dua kali, masing-

masing dengan tinggi air 50 mm, yaitu satu bulan dan dua bulan setelah 

transplantasi tanaman padi dilakukan. Oleh karena itu, kebutuhan tambahan 

air ini dapat dihitung sekitar 3,3 mm/hari. 

Pola tata tanam yang dilakukan dimulai pada bulan November. Persiapan 

lahan dimulai lebih awal, dari minggu pertama hingga minggu kedua. Tanaman 

sawah dalam skema yang dibuat adalah padi yang ditanam dua kali setiap tahun, 

diikuti dengan palawija berupa jagung. 

Kebutuhan bersih air untuk padi, dihitung dengan persamaan (2.14): 

         NFRPadi = ETc + P – Re + WLR                            (2.14) 
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Kebutuhan bersih air untuk palawija, dihitung dengan persamaan (2.15): 

            NFRPalawija = ETc – Re                                                   (2.15) 

dimana : NFR  = kebutuhan air irigasi (mm/hari) 

ETc    = penggunaan konsumtif (mm/hari) 

P        = perkolasi (mm/hari) 

Re      = curah hujan efektif (mm/hari) 

WLR = penggantian lapisan air (mm/hari) 

Hasil perhitungan evapotranspirasi dapat dilihat di Lampiran 5. 

2.12 Debit Banjir dan Debit Andalan 

Debit banjir dan debit andalan merupakan faktor utama yang digunakan 

sebagai dasar dalam perencanaan struktur bendung. Debit banjir merupakan debit 

maksimum yang dapat terjadi dalam sungai berdasarkan data yang ada, sementara 

debit andalan merupakan debit minimum yang harus terjadi dalam sungai untuk 

memenuhi kebutuhan air di lahan pertanian dan untuk masyarakat sekitar. Dalam 

perhitungan debit banjir dan debit andalan, beberapa metode perhitungan dapat 

digunakan, termasuk metode Haspers, terutama karena luas DAS Bedog 62,978 

km2. Adapun langkah-langkah perhitungan debit yang dapat dilakukan dengan 

metode Haspers. 

1. Nilai koefisien pengaliran (α), menunjukkan sejauh mana hujan yang jatuh di 

suatu daerah akan berkontribusi pada aliran permukaan sungai. Koefisien 

pengaliran, dihitung dengan persamaan (2.16): 

α = 
1 + (0,012 × A0,70)

1 + (0,075 × A0,70)
                                       (2.16) 

dimana : α = koefisien limpasan air hujan 

               A = luas DAS (km2) 

2. Waktu konsentrasi hujan (tc = t), dihitung dengan persamaan (2.17): 

t = 0,1 × L0,8 × i
-0,30

                                       (2.17) 

dimana : t  = waktu konsentrasi hujan (jam) 

               L = panjang sungai dari hulu ke titik bendung (km) 

   i  = kemiringan sungai (%) 

3. Koefisien reduksi (β), menunjukkan efek dari berbagai faktor, seperti 

penggunaan lahan, tanaman, dan penampungan air, yang dapat mengurangi 

aliran permukaan dan mengubah bagaimana hujan meresap ke dalam tanah 
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atau mengalir ke sungai. Koefisien pengurangan luas daerah hujan, dihitung 

dengan persamaan (2.18): 

1

β
 = 1 + 

t + (3,70 × 100,40t)

t2 + 15
×

A0,75

12
                           (2.18) 

4. Nilai curah hujan (r) untuk lama hujan tertentu (t) dan curah hujan harian 

maksimum (R24), dihitung dengan persamaan (2.19), (2.20), dan persamaan 

(2.21): 

Untuk t < 2 jam: 

r = 
t × R24

t + 1 - 0,0008 × (260 - R24) × (2 - t)2                           (2.19) 

Untuk 2 jam < t < 19 jam: 

    r = 
t × R24

t + 1
                            (2.20) 

Untuk 19 jam < t < 30 hari: 

  r = 0,707 × R24 × (t + 1)
1

2                           (2.21) 

5. Nilai intensitas hujan (I = q), dihitung dengan persamaan (2.22): 

    I = 
r

3,6 × t
                                       (2.22) 

6. Debit banjir rencana pada periode ulang tertentu dapat ditemukan dalam 

Tabel 2.12, yang dapat dihitung menggunakan persamaan (2.23): 

           Q = α × β × q × A                           (2.23) 

Tabel 2.12 Perhitungan Nilai Debit Banjir 

Periode 

Ulang 

Tahun 

R24 

(mm) 

tc = t 

(jam) 

r 

(mm) 
𝛂 𝛃 

I = q 

(mm/jam) 

Q 

(m3/s) 

5 72,128 4,347 58,638 0,515 0,805 3,747 97,898 

10 81,760 4,347 66,468 0,515 0,805 4,248 110,971 

20 89,835 4,347 73,033 0,515 0,805 4,667 121,932 

25 94,167 4,347 76,555 0,515 0,805 4,892 127,811 

50 103,636 4,347 84,253 0,515 0,805 5,384 140,662 

100 113,298 4,347 92,108 0,515 0,805 5,886 153,777 
 

Dalam menghitung debit andalan, digunakan curah hujan rerata terendah dari 

data curah hujan maksimum yang tersedia. Setelah itu, dilakukan perhitungan yang 

sama dengan yang digunakan dalam perhitungan debit banjir untuk mengestimasi 
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debit andalan selama 10 tahun. Debit-debit yang diperoleh kemudian diurutkan dari 

yang tertinggi ke yang terendah, dengan probabilitas diurutkan dari yang terendah 

ke yang tertinggi. Dalam perhitungan ini, digunakan debit yang memiliki 

probabilitas terjadinya sebanyak 80%, karena bendung ini direncanakan untuk 

menjadi sumber air irigasi. Hasil perhitungan interpolasi menunjukkan bahwa debit 

andalan dengan probabilitas 80% adalah 11,9886 m3/s. Hal ini juga dapat dilihat 

dalam Tabel 2.13 yang terlampir di bawah ini. 

Tabel 2.13 Perhitungan Nilai Debit Andalan 

Data ke-n Probabilitas 
r 

(mm) 

Q 

(m3/s) 

1 9% 30,801 51,423 

2 18% 29,647 49,497 

3 27% 28,291 47,234 

4 36% 22,602 37,735 

5 45% 9,973 16,650 

6 55% 9,858 16,458 

7 64% 9,273 15,482 

8 73% 8,666 14,467 

9 82% 6,810 11,369 

10 91% 4,439 7,411 
 

2.13 Perencanaan Hidraulik Bendung 

2.13.1 Debit Banjir 

Dalam perencanaan hidraulik bendung, digunakan debit rencana maksimum 

dengan periode ulang 50 tahun. Penggunaan periode ulang 50 tahun dipilih karena 

Sungai Bedog termasuk dalam kategori sungai sedang. Data debit banjir ini diperoleh 

melalui perhitungan menggunakan metode Haspers. Metode Haspers dipilih karena 

metode ini memberikan nilai debit banjir rencana yang lebih tinggi dibandingkan 

dengan hasil perhitungan menggunakan metode Melchior dan Weduwen. Dari hasil 

pengujian data dengan menggunakan metode Haspers sebelumnya, diperoleh data 

debit banjir rencana dengan periode ulang 50 tahun sebesar 140,662 m3/s. 

 

 

 

 



26 

 
 

2.13.2 Data Sungai dan Sawah 

Dalam perencanaan bendung, terdapat beberapa parameter yang perlu 

diketahui mengenai sungai dan lahan sawah, seperti elevasi lahan sawah dan luas 

area sawah yang akan mendapatkan aliran air. Informasi mengenai sungai dan lahan 

sawah dapat ditemukan dalam Tabel 2.14 yang tercantum di bawah ini. 

Tabel 2.14 Data Sungai dan Sawah 

Debit Andalan (QAndalan) 11,989      m3/s 

Luas Sawah 141,459    ha 

NFR 1,688        l/s/ha 

Debit untuk Sawah (QSawah) 0,369        m3/s 

Debit Banjir Rencana (Q50) 140,662    m3/s 

Panjang Sungai 28,4          km 

Kemiringan (S) 0,026 

Luas DAS 62,978      km2 

Lebar Sungai 22,7          m 

Elevasi Lahan Sawah Tertinggi 103           m 

Elevasi Dasar Sungai Hulu 100           m 

Elevasi Dasar Sungai Hilir 99,114      m 
 

2.13.3 Tipe Mercu Bendung 

Mercu bendung merupakan struktur tertinggi yang terletak di tengah aliran 

sungai, yang mana berfungsi untuk menyadap atau membendung aliran air sungai.  

Elevasi atau ketinggian mercu bendung dipengaruhi oleh tinggi muka air yang 

diinginkan. Terdapat beberapa tipe mercu bendung yang berbeda, tergantung pada 

tujuan dan fungsinya. 

Di Indonesia, mercu bendung tipe bulat dan Ogee sering menjadi pilihan 

dalam pembangunan bendung. Kedua tipe mercu ini bisa dikerjakan dengan 

menggunakan beton, batu, atau kombinasi dari kedua material tersebut. Sifat utama 

dari mercu bulat dan Ogee adalah memiliki profil ambang yang tajam. Gambar 2.4 

menampilkan bentuk kedua mercu ini. Saat memilih tipe mercu bendung ini, penting 

untuk memilih desain yang sederhana agar mempermudah pelaksanaan konstruksi. 

Selain itu, disarankan agar lebar mercu dibuat sebesar mungkin agar lebih kuat 

menahan tekanan hidrostatis. 
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Gambar 2.4 Bentuk-Bentuk Mercu 

(Sumber: Standar Perencanaan Irigasi KP-02) 

Dalam perencanaan bendung ini, tipe mercu bulat dipilih karena bentuk bulat 

yang memiliki satu jari-jari, yang membuatnya lebih mudah untuk 

diimplementasikan di lapangan dibandingkan dengan bentuk lainnya. Mercu bulat 

memiliki koefisien debit yang lebih besar daripada mercu ambang lebar. Hal ini 

berarti bahwa mercu bulat mampu mengalirkan lebih banyak air melalui bendung 

pada tingkat debit yang sama, sehingga dapat membantu mengurangi tingkat 

ketinggian air di hulu selama banjir. Selain itu, mercu bulat juga mampu membentuk 

lengkungan streamline yang mengarahkan aliran air secara lebih efektif, yang mana 

dapat mengurangi turbulensi dan mencegah erosi di sekitar bendung. 

2.13.4 Elevasi Mercu Bendung 

Elevasi mercu bendung bergantung pada elevasi sawah yang akan menerima 

aliran air. Elevasi sawah tersebut harus diperhitungkan dengan mempertimbangkan 

beberapa faktor tambahan yang memengaruhi elevasi mercu bendung. Berikut 

merupakan nilai-nilai faktor yang perlu dipertimbangkan dalam perhitungan elevasi 

mercu bendung. 

Tabel 2.15 Penentuan Elevasi Mercu Bendung 

No. Uraian Ketinggian (m) 

1 Elevasi tertinggi sawah yang akan dialiri X 

2 Tinggi air di sawah 0,10 

3 Kehilangan tekanan;  

 - dari saluran tersier ke sawah 0,10 

 - dari saluran sekunder ke saluran tersier 0,10 

 - dari saluran primer ke saluran sekunder 0,10 

 - karena kemiringan sungai 0,15 
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Lanjutan Tabel 2.15 Penentuan Elevasi Mercu Bendung 

No. Uraian Ketinggian (m) 

 - karena alat-alat ukur 0,40 

 - dari intake ke saluran induk/kantong lumpur 0,20 

 - bangunan lain antara lain kantong lumpur 0,25 

4 Untuk eksploitasi 0,10 

Elevasi mercu bendung X + 1,50 

(Sumber: Mawadi & Memed, 2010) 

Berdasarkan Tabel 2.15 mengenai penentuan elevasi mercu bendung dan 

Tabel 2.14 mengenai data sawah dan sungai, data elevasi sawah tertinggi sebesar 103 

m digunakan dalam menghitung elevasi mercu bendung. Jadi, elevasi mercu bendung 

sebesar 104,5 m. Namun, karena tinggi mercu (P) sebaiknya tidak melebihi 4 m dan 

harus minimal 0,5H, maka tinggi mercu bendung yang digunakan adalah 4 m. Oleh 

karena itu, untuk mencapai elevasi ini, lantai bagian hulu ditinggikan dengan 

melakukan penimbunan sebanyak 0,5 m dari dasar sungai. 

2.13.5 Lebar Efektif Bendung 

Panjang mercu bendung yang direncanakan dapat diambil dari angka 1,0 

hingga 1,2 kali lebar sungai (Mawadi & Memed, 2010). Selanjutnya, lebar mercu 

yang sebenarnya (B) dapat dihitung dengan mengurangkan lebar total bangunan 

pembilas dari panjang mercu normal. Selain itu, karena terdapat pilar di antara mercu, 

perlu menghitung lebar efektif mercu (Be) dengan menggunakan persamaan (2.24) 

berikut. 

              Be = B – 2 (n × Kp × Ka) × H1                                       (2.24) 

dimana : Be = lebar efektif mercu (m) 

               Bb = lebar mercu yang sebenarnya (m) 

      n   = jumlah pilar 

      Kp = koefisien kontraksi pilar (Tabel 2.16) 

      Ka = koefisien kontraksi pangkal bendung (Tabel 2.16) 

      H1 = tinggi energi (m) 
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Tabel 2.16 Nilai Koefisien Ka dan Kp 

Bentuk Pilar Ka 

Untuk pilar berujung segi empat dengan sudut-sudut yang dibulatkan 

pada jari-jari yang hampir sama dengan 0,1 dari tebal pilar 
0,02 

Untuk pilar berujung bulat 0,01 

Untuk pilar berujung runcing 0 

Bentuk Pangkal Tembok Kp 

Untuk pangkal tembok segi empat dengan tembok hulu pada 90o ke arah 

aliran 
0,20 

Untuk pangkal tembok bulat dengan tembok hulu pada 90o ke arah aliran 

dengan 0,5 H1 > r > 0,15 H1 
0,10 

Untuk pangkal tembok bulat dimana r > 0,5 H1 dan tembok hulu tidak 

lebih dari 45o ke arah aliran 
0 

 

(Sumber: Standar Perencanaan Irigasi KP-02) 

Dalam perencanaan bendung, lebar bendung diambil maksimal 1,2 kali lebar 

sungai rata-rata, yang menghasilkan lebar bendung sebesar 27,24 m. Untuk 

bangunan pembilas di bendung, direncanakan memiliki pintu selebar 1,2 m dan satu 

pilar dengan tebal 1,3 m di sisi kiri mercu, sehingga total lebar bangunan pembilas 

adalah 2,5 m. Dengan demikian, dapat dihitung lebar efektif mercu bendung (Be) 

menggunakan persamaan di atas, yang memberikan hasil sebesar 26,861 m, dengan 

asumsi bahwa lebar mercu yang sebenarnya (B) sama dengan lebar bendung. 

2.13.6 Elevasi Muka Air Banjir Hulu 

Adapun langkah-langkah yang dapat dilakukan dalam menentukan elevasi 

muka air banjir hulu adalah sebagai berikut. 

1. Nilai dari fungsi r (jari-jari mercu) digunakan dari pasangan batu yang 

nilainya 0,4 dikali H1 (tinggi energi di atas mercu), dengan nilai H1 

diasumsikan 2 m terlebih dahulu. Nilai fungsi r dihitung dengan persamaan 

(2.25): 

r = 0,4 × H1                                                                                       (2.25) 

r = 0,4 × 2 

r = 0,8 m 
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2. Nilai dari fungsi P merupakan setengah dari tinggi mercu, yang menghasilkan 

hasil sebesar 2 m. 

3. Nilai koefisien debit, dihitung dengan persamaan (2.26): 

                                              Cd = C0 × C1 × C2                                               (2.26) 

dimana : Cd = koefisien debit 

C0 = fungsi H1/r (Gambar 2.5) 

C1  = fungsi p/H1 (Gambar 2.6) 

C2 = fungsi p/H1 dan kemiringan muka hulu bendung 

(Gambar 2.7)  

 
Gambar 2.5 Nilai koefisien C0 untuk Bendung Mercu Bulat 

(Sumber: Standar Perencanaan Irigasi KP-02) 

 

Gambar 2.6 Nilai koefisien C1 untuk Bendung Mercu Bulat 

(Sumber: Standar Perencanaan Irigasi KP-02) 

 

Gambar 2.7 Nilai koefisien C2 untuk Bendung Mercu Bulat 

(Sumber: Standar Perencanaan Irigasi KP-02) 
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4. Setelah mendapatkan nilai koefisien debit (Cd), debit dapat dihitung dengan 

melakukan iterasi pada nilai H1 hingga mencapai nilai Q yang sama dengan 

debit banjir rencana, sesuai dengan perhitungan dalam persamaan (2.27) 

berikut: 

Q = Cd × 
2

3
 × √

2

3
g × b × H1

1,5
        (2.27) 

Q = 1,358 × 
2

3
 × √

2 

3
× 9,81 × 26,861 × 1,7231,5 

Q = 140,662 m3/s 

dimana : Q  = debit banjir rencana (m3/s) 

                Cd = koefisien debit 

     g     = percepatan gravitasi (m/s2) 

     b   = lebar efektif mercu (m) 

     H1  = tinggi energi di atas mercu (m) 

5. Setelah memperoleh tinggi energi di atas mercu, dilakukan perhitungan 

kecepatan aliran dan tinggi kecepatan aliran dengan menggunakan persamaan 

(2.28) dan persamaan (2.29) berikut. 

V = 
Q

Be × H1 × 1
                                                                                       (2.28) 

V = 
140,662

26,861 × 1,723 × 1
 

V = 3,039 m/s 

k = 
 V2

2g
                                                                                                   (2.29) 

k = 
 3,039

2

2 × 9,81
 

k = 0,471 m 

dimana : V  = kecepatan aliran (m/s) 

               Q  = debit banjir rencana (m3/s) 

                Be = lebar efektif mercu (m) 

                  H1 = tinggi energi di atas mercu (m) 

  k   = tinggi kecepatan aliran (m) 

                  g   = percepatan gravitasi (m/s2) 

 

 

 



32 

 
 

2.13.7 Elevasi Muka Air Hilir 

Dalam menentukan tinggi muka air di bagian hilir, digunakan trial and error 

dan persamaan Manning. Nilai ketinggian air di bagian hilir (h) dimasukkan ke dalam 

persamaan hingga ditemukan nilai debit (Q) yang sesuai dengan debit banjir rencana. 

Persamaan yang digunakan adalah sebagai berikut: 

A = (B × h)                                       (2.30) 

P = B + 2h                                                   (2.31) 

                 R = 
A

P
                                                   (2.32) 

      V = 
1

n
 × R

2
3⁄  × S

1
2⁄
                                       (2.33) 

             Q = A × V                                       (2.34) 

dimana : A  = luas penampang sungai (m2) 

P  = keliling basah (m) 

R = jari-jari hidraulik (m) 

V  = kecepatan aliran pada kedalaman kritis (m/s) 

               Q  = debit banjir rencana (m3/s) 

                  n   = koefisien Manning, bergantung pada bahan saluran (Tabel 2.17) 

Tabel 2.17 Koefisien Manning 

Bahan Koefisien Manning (n) 

Besi tuang dilapis 0,014 

Kaca 0,010 

Saluran beton 0,013 

Bata dilapis mortar 0,015 

Pasangan batu disemen 0,025 

Saluran tanah bersih 0,022 

Saluran tanah 0,030 

Saluran dengan dasar batu dan tebing rumput 0,040 

Saluran pada galian batu padas 0,040 

 (Sumber: Triatmodjo, 1993) 

Berikut merupakan hasil perhitungan tinggi muka air banjir hilir yang 

menghasilkan nilai tinggi muka air banjir hilir sebesar 0,6013 m dari dasar sungai 

seperti pada Tabel 2.18 berikut. 
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Tabel 2.18 Perhitungan Tinggi Muka Air Banjir Hilir 

B 

(m) 

S 

(%) 
m n 

h 

(m) 

A 

(m2) 

P 

(m) 

R 

(m) 

V 

(m/s) 

Q 

(m3/s) 

27,24 2,6 0 0,013 0,6 16,344 28,440 0,575 8,574 140,127 

27,24 2,6 0 0,013 0,6013 16,380 28,443 0,576 5,021 140,662 

27,24 2,6 0 0,013 0,7 19,068 28,640 0,666 9,457 180,331 
 

2.13.8 Kolam Olak 

Kolam olak merupakan bagian yang terletak di bagian hilir bendung yang 

memiliki peran dalam mengatur aliran air dan mengontrol sedimentasi di sekitar 

bendung. Kolam olak berperan dalam mengendalikan kecepatan aliran air dan 

memisahkan partikel padatan yang terbawa oleh air sebelum mencapai sungai di 

bawah bendung. Prinsipnya, dengan adanya kolam olak, air dapat disaring dari 

sedimen, sehingga air yang mengalir ke sungai menjadi lebih bersih dan erosi tanah 

dapat berkurang. 

Tipe kolam olak yang akan direncanakan bergantung pada energi air yang 

masuk, yang dinyatakan dengan bilangan Froude (Fr) dan pada bahan konstruksi 

kolam olak. Berdasarkan Standar Perencanaan Irigasi KP-02, bilangan Froude (Fr) 

dapat dikelompokkan sebagai berikut. 

• Apabila bilangan Froude (Fr) kurang dari 1,7, maka kolam olak tidak 

diperlukan. 

• Apabila bilangan Froude (Fr) berada diantara 1,7 hingga 2,5, maka kolam 

olak diperlukan untuk meredam energi secara efektif. 

• Apabila bilangan Froude (Fr) berada diantara 2,5 hingga 4,5, maka 

menggunakan kolam olak USBR tipe IV. 

• Apabila bilangan Froude (Fr) lebih dari 4,5, maka menggunakan kolam olak 

USBR tipe III. 

Adapun langkah-langkah yang dapat dilakukan dalam mendesain kolam olak 

menurut Standar Perencanaan Irigasi KP-02 adalah sebagai berikut. 

1. Kecepatan air saat awal loncat air, dihitung dengan persamaan (2.35): 

v1 = √2g (0,5H1 + z)                                                                           (2.35) 

v1=√2 × 9,81(0,5 × (1,723) + 7,109) 

v1= 12,505 m/s 
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dimana : v1 = kecepatan air saat awal loncat air (m/s) 

   ge  = percepatan gravitasi (m/s2) 

   H1 = tinggi energi di atas mercu (m) 

   z2  = tinggi jatuh air dari mercu (m) 

2. Ketinggian air saat loncat air, dihitung dengan persamaan: 

y
1
 = 

Q

Be  × v1
                                                                                       (2.36) 

y
1
=

140,662

26,861 × 12,505
 

y1 = 0,419 m 

dimana : y1  = ketinggian air sebelum loncat air (m) 

   Qe = debit banjir 50 tahun (m3/s) 

   Be = lebar efektif mercu (m) 

   v1  = kecepatan air saat awal loncat air (m/s) 

 

3. Bilangan Froude (Fr), ketinggian air setelah loncat air, dan kecepatan air 

setelah loncat air, dihitung dengan persamaan (2.37) dan persamaan (2.38): 

Fr = 
v1

√g × y
1

                                                                                       (2.37) 

Fr= 
12,505

√9,81 × 0,419
 

Fr=  6,170 

y2 =
y1

2
 √1 + 8 ×  Fr

2 – 1                                                               (2.38) 

y2 =
0,419

2
 √1 + 8 × (6,170)

2
 - 1 

y2 = 3,450 m 

dimana : Fr = bilangan Froude (Fr) 

   v1  = kecepatan air saat awal loncat air (m/s) 

   ge  = percepatan gravitasi (m/s2) 

   y1 = ketinggian air sebelum loncat air (m) 

   y2 = ketinggian air saat loncat air (m) 
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Tinggi ambang ujung (n) dan panjang kolam olak (L), dihitung dengan 

persamaan (2.39) dan persamaan (2.40): 

n = 
y

1 
× 18 + Fr

18
                                                                                       (2.39) 

n = 
0,4188 × 18 + 6,1696

18
 

n = 0,5623 m 

L = 2,7 × y2                                                                                       (2.40) 

L = 2,7 × 3,4505 

L = 9,3162 ≈ 9,4 m 

dimana : n   = tinggi ambang ujung (m) 

               y1 = ketinggian air sebelum loncat air (m) 

   Fr = bilangan Froude 

   L  = panjang kolam olak (m) 

   y2 = ketinggian air saat loncat air (m) 

Panjang kolam olak dapat sangat diperpendek dengan menggunakan blok-

blok halang dan blok-blok muka. Dimensi kolam olak USBR tipe III yang dapat 

digunakan jika bilangan Froude lebih dari 4,5 dapat dilihat pada Gambar 2.8. 

 
Gambar 2.8 Kolam Olak USBR Tipe III 

(Sumber: Standar Perencanaan Irigasi KP-02) 

Berdasarkan bilangan Froude (Fr) yang diperoleh dari perhitungan di atas 

lebih besar dari 4,5, maka dimensi pada kolam olak bendung ini dapat mengikuti 

persyaratan yang telah ditetapkan dalam Standar Perencanaan Iirgasi KP-02 yang 

telah disebutkan di atas. 

2.13.9 Saluran Pengambilan (Intake) 

Saluran pengambilan (intake) merupakan saluran yang berfungsi sebagai 

pintu air yang dibuat untuk mengambil atau mengarahkan air dari sungai ke dalam 
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saluran pengairan, dengan tujuan mencegah masuknya partikel padatan dan sedimen 

ke dalam saluran. Saluran intake terbagi menjadi dua jenis, yaitu saluran terbuka dan 

saluran tertutup. Saluran pengambilan air terbuka menerapkan sistem saluran tanpa 

pipa, yang secara umum digunakan untuk debit aliran besar. Sebaliknya, untuk 

saluran pengambilan air tertutup, pipa digunakan sebagai sarana saluran untuk aliran 

dengan tingkat debit yang lebih kecil. 

Dalam perencanaan desain bendung ini, digunakan sistem saluran 

pengambilan terbuka. Adapun persamaan (2.41) yang dapat digunakan dalam 

mendesain saluran intake menurut Standar Perencanaan Irigasi KP-02 adalah sebagai 

berikut. 

                                Q = μ b a √2gz                                                               (2.41) 

dimana : Q = debit intake (m3/s) 

   μ  = koefisien debit 

   b  = lebar bukaan (m) 

   a  = tinggi bukaan (m) (diasumsikan a = b) 

   ge = percepatan gravitasi (m/s2) 

   z  = kehilangan tinggi energi pada bukaan (m) 

Dalam hal ini, diasumsikan bahwa lebar bukaan pintu sama dengan tinggi 

bukaan pintu, sehingga dimensi saluran pengambilan dapat dihitung. Untuk 

mencegah benda-benda yang terbawa oleh debit intake yang masuk, direncanakan 

puncak bukaan berada di bawah permukaan air hulu. Perancangan saluran intake 

dilakukan terlebih dahulu untuk menentukan lebar bangunan pengambilan. Oleh 

sebab itu, beberapa asumsi yang digunakan adalah sebagai berikut. 

Jumlah pintu pengambilan  = 1 

Debit intake   = 0,281 m3/s 

Debit intake yang telah dihitung sebelumnya telah ditingkatkan sebesar 120% 

dari kebutuhan pengambilan awalnya. Hal ini dilakukan untuk meningkatkan 

fleksibilitas dan memastikan bahwa proyek ini dapat memenuhi kebutuhan yang 

paling tinggi selama masa berlangsungnya proyek. 

Luas daerah irigasi   = 141,459 ha 

Tinggi bersih bukaan pintu  = 0,355 ≈ 0,4 m 

Lebar bersih bukaan pintu  = 0,421 ≈ 0,5 m 
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Koefisien debit    = 0,8 

Tinggi bersih bukaan pintu merupakan hasil dari trial and error dari 

persamaan debit. Setelah debit intake saluran dihitung, kecepatan aliran dapat 

ditentukan menggunakan persamaan berikut. 

Q = μ b a √2gz                                                                                       (2.42) 

Q = 0,8 × 0,5 × 0,355 √2 × 9,81 × 0,2 

Q = 0,281 m3/s 

A = abukaan pintu × bbukaan pintu                                                               (2.43) 

A = 0,4 × 0,5 

A = 0,2 m2 

V = 
Q

A
                                                                                                               (2.44) 

V =
0,281

0,2
 

V = 1,406 m/s 

dimana : A = luas penampang intake (m2) 

        Q = debit intake (m3/s) 

      V = kecepatan aliran (m/s) 

2.13.10 Saluran Pengendap/Kantong Lumpur 

Saluran pengendap, yang sering disebut sebagai kantong lumpur, merupakan 

bagian dari struktur bendung yang dirancang untuk mengendapkan atau 

mengumpulkan sedimen, lumpur, atau endapan yang terbawa oleh air yang mengalir 

melewati bendung. Dalam merencanakan saluran pengendap, ada beberapa parameter 

yang harus dihitung. Salah satunya adalah kecepatan endap (w). Grafik dalam Gambar 

2.9 menunjukkan hubungan antara diameter saringan dan kecepatan endap (w) pada 

air tenang, yang berguna untuk perhitungan kecepatan endap ini. 

Untuk membaca grafik Shield, perlu mempertimbangkan parameter suhu air 

dan ukuran diameter partikel sedimen yang ada di sungai. Di DI Yogyakarta, umumnya 

menggunakan suhu air sungai berkisar antara 26oC-30oC dan diameter partikel 0,07 

mm. Dengan menggunakan parameter-parameter ini, diperoleh nilai kecepatan endap 

(w) sebesar 0,0046 m/s. 
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Gambar 2.9 Hubungan Diameter Saringan dan Kecepatan Endap Air Tenang 

(Sumber: Standar Perencanaan Irigasi KP-02) 

Adapun langkah-langkah yang dapat dilakukan dalam mendesain saluran 

pengendap menurut Standar Perencanaan Irigasi KP-02 adalah sebagai berikut. 

1. Diketahui kecepatan endap (w) sebesar 0,0046 m/s dan debit aliran irigasi 

(Qn) sebesar 0,281 m3/s. Kedua parameter ini akan digunakan dalam 

perencanaan saluran pengendap. 

2. Luasan memanjang saluran pengendap, dihitung dengan persamaan (2.45): 

L × B = 
Q

n

W
                                                                                       (2.45) 

L × B =
0,281

 0,0046
 

L × B = 61,114 

dimana : L   = panjang kolam sedimen (m) 

                    B  = lebar kolam sedimen (m) 

     Qn = debit aliran irigasi (m3/s) 

     W  = kecepatan endap sedimen (m/s) 

3. Agar aliran di dalam saluran pengendap tidak mengalami meandering, maka 

direncanakan 
L

B
 > 8 dan pada perencanaan ini digunakan 

L

B
 = 16. Panjang dan 

lebar saluran pengendap, dihitung dengan persamaan (2.46) dan persamaan 

(2.47): 
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L

B
= 16  

B = √
61,114

16
                                                                                        (2.46) 

B = 1,954 ≈ 2 m 

L = 16 × B                                                                                       (2.47) 

L = 16 × 1,954 

L = 31,270 ≈ 31 m 

L

B
 = 

31

2
 = 15,5 > 8 (OK)  

4. Nilai kecepatan rata-rata eksploitasi normal (Vn) dipilih sebesar 0,35 m/s 

karena debit aliran irigasi (Qn) berada diantara 0,15 m3/s – 0,3 m3/s, serta 

untuk mencegah pertumbuhan vegetasi dan menghindari pengendapan 

partikel yang lebih besar di bagian hilir intake. 

5. Luas penampang basah, dihitung dengan persamaan (2.48): 

An = 
Q

n

Vn
                                                                                                   (2.48) 

𝐴𝑛 =
0,281

0,35
 

An  = 0,803 m2 

dimana : An = luas penampang basah saluran (m2) 

               Qn = debit aliran irigasi (m3/s) 

   Vn = kecepatan rata-rata eksploitasi normal (m/s) 

6. Kedalaman air, dihitung dengan persamaan (2.49): 

Hn = 
An

B
                                                                                                   (2.49) 

Hn=
0,803

2
 

Hn= 0,402  

7. Keliling basah, dihitung dengan persamaan (2.50): 

P = b + 2 × h √m2 + 1                                                                           (2.50) 

P = 2 + 2 × 0,402 √1
2 + 1 

P = 3,136 m 

dimana : P = keliling basah (m) 

               b = lebar saluran pengendap (m) 
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   h = kedalaman air (m) 

   m = kemiringan talud (1:1) 

8. Jari-jari hidrolis, dihitung dengan persamaan (2.51): 

Rn=
A

P
                                                                                                   (2.51) 

Rn=
0,803

3,136
 

Rn= 0,256 m 

9. Lebar dasar saluran, dihitung dengan persamaan (2.52): 

b = B – 2 (0,5 × 2 × H)                                                                           (2.52) 

b = 2 – 2 (0,5 × 2 × 0,401) 

b = 1,197 m 

10. Memeriksa keamanan saluran pengendap: 

• Menurut Standar Perencanaan Irigasi KP-02, disarankan untuk 

mengambil debit pembilasan sebanyak yang dapat diakomodasi oleh 

pintu pengambilan dan perbedaan tinggi permukaan air. 

• Kecepatan rata-rata yang diperlukan selama pembilasan sedimen (Vs) 

yang masuk ke dalam saluran pengendp berupa pasir halus sebesar 1 

m/s. Luas penampang saluran pengendap saat kosong, dihitung dengan 

persamaan (2.53): 

As =
Qs

Vs
                                                                                       (2.53) 

As=
0,281

1
 

As= 0,281 m2 

• Tinggi endapan lumpur, dihitung dengan persamaan (2.54): 

hs =
As

b
                                                                                       (2.54) 

hs =
0,281

1,197
 

hs = 0,235 m 

• Bilangan Froude (Fr) saluran pengendap, dihitung dengan persamaan 

(2.55): 

Fr=
V

√gh
                                                                                       (2.55) 
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Fr=
1

√9,81 × 0,235
 

Fr = 0,659 < 1 (OK) 

• Tinggi endapan lumpur pada hilir saluran pengendap, dihitung dengan 

persamaan (2.56) dan persamaan (2.57): 

In=
Vn

(k (Rn
2

3⁄ ))2
                                                                           (2.56) 

In=
0,35

(35 (0,256
2

3⁄ ))2
 

In = 0,000615 

m = In × L                                                                           (2.57) 

m = 0,000615 × 31 

m = 0,019 m 

 
Gambar 2.10 Dimensi Saluran Pengendap 

2.13.11 Saluran Induk 

Saluran induk, yang sering disebut sebagai saluran primer, merupakan saluran 

utama yang mengalirkan air dari sungai utama ke saluran sekunder, kemudian ke 

petak-petak tersier. Berikut merupakan potongan melintang dari saluran induk. 

 
Gambar 2.11 Potongan Melintang Saluran Induk 

Adapun langkah-langkah yang dapat dilakukan dalam mendesain saluran 

induk menurut Standar Perencanaan Irigasi KP-02 adalah sebagai berikut. 
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1. Menentukan debit air (Q) yang dibutuhkan, yaitu 0,234 m3/s. 

2. Kecepatan aliran standar saluran induk ditentukan melalui Tabel 2.19. 

Tabel 2.19 Kecepatan Aliran Standar 

Q 

(m3/s) 

Kecepatan Aliran Standar 

(m/s) 

< 0,15 0,25 – 0,30 

0,15 – 0,30 0,25 – 0,35 

0,30 – 0,40 0,30 – 0,40 

0,40 – 0,50 0,35 – 0,45 

0,50 – 0,75 0,40 – 0,50 

0,75 – 1,50 0,40 – 0,55 

1,50 – 3,00 0,45 – 0,60 

3,00 – 4,50 0,50 – 0,65 

4,50 – 6,00 0,55 – 0,70 

6,00 – 7,50 0,60 – 0,70 

7,50 – 9,00 0,60 – 0,70 

9,00 – 11,00 0,60 – 0,70 

11,00 – 15,00 0,60 – 0,70 

15,00 – 25,00 0,65 – 0,70 

(Sumber: Pedoman Kriteria Perencanaan Teknis Irigasi) 

3. Luas penampang saluran (A), dihitung dengan persamaan (2.58): 

A = 
Q

V
                                                                                                   (2.58) 

A = 
0,2343

0,35
 

A = 0,669 m2 

dimana : Q = debit air yang dibutuhkan untuk irigasi (m3/s) 

   V = kecepatan aliran standar saluran induk (m/s) 

4. Kemiringan talud ditentukan melalui Tabel 2.20 dan perbandingan b/h 

ditentukan melalui Tabel 2.21. 
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Tabel 2.20 Kemiringan Talud Minimum 

D Perbandingan Kemiringan 

D ≤ 1,0 1,0 : 1,0 

1,0 < D ≤ 2,0 1,0 : 1,5 

D > 2,0 1,0 : 2,0 

(Sumber: Standar Perencanaan Irigasi KP-03) 

Tabel 2.21 Perbandingan b/h 

Q 

(m3/s) 

Perbandingan b/h 

(n) 

< 0,30 1,0 

0,30 – 0,50 1,5 

0,50 – 1,50 2,0 

1,50 – 3,00 2,5 

3,00 – 4,50 3,0 

4,50 – 6,00 3,5 

6,00 – 7,50 4,0 

7,50 – 9,00 4,5 

9,00 – 11,00 5,0 

11,00 – 15,00 6,0 

15,00 – 25,00 8,0 

25,00 – 40,00 10,0 

40,00 – 80,00 12,0 

(Sumber: Standar Perencanaan Irigasi KP-03) 

5. Tinggi muka air dan lebar dasar pada saluran induk, dihitung dengan 

persamaan (2.59) dan persamaan (2.60): 

A = (
b

h
 + m)  × h2

  

0,669 = (1 + 1) × h2 

h = 0,579 m                     (2.59) 

A = h × (b + mh)         (2.60) 

0,669 = 0,579 × (b + 1 × 0,579) 

b = 0,579 m 

dimana : A = luas penampang saluran (m2) 
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   h = tinggi muka air (m) 

 b = lebar dasar saluran (m) 

 m = kemiringan talud 

6. Keliling basah pada saluran induk, dihitung dengan persamaan (2.61): 

P = b + 2 × h √m2 + 1         (2.61) 

P = 0,579 + 2 × 0,579 √12 + 1 

P = 2,215 m 

7. Jari-jari hidraulik, dihitung dengan persamaan (2.62): 

R =
A

P
           (2.62) 

R =
0,669

2,215
 

R = 0,302 m 

8. Tinggi jagaan saluran ditentukan melalui Tabel 2.22. 

Tabel 2.22 Tinggi Jagaan Saluran 

Q (m3/s) Tinggi Jagaan (m) 

< 0,5 0,40 

0,5 – 1,5 0,50 

1,5 – 5,0 0,60 

5,0 – 10,0 0,75 

10,0 – 15,0 0,85 

> 15,0 1,00 

(Sumber: Standar Perencanaan Irigasi KP-03) 

9. Ketinggian saluran, dihitung dengan persamaan (2.63): 

D = h + W          (2.63) 

D = 0,579 + 0,4 

D = 0,979 m 

dimana : h   = tinggi muka air (m) 

   W = tinggi jagaan (m) 

10. Lebar permukaan air pada saluran induk, dihitung dengan persamaan (2.64): 

B′ = b + 2mh          (2.64) 

B′ = 0,579 + 2 × 1 × 0,579 

B′ = 1,736 m 
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11. Lebar sisi atas saluran induk, dihitung dengan persamaan (2.65): 

b′ = D × m 

b′ = 0,979 × 1 

b′ = 0,979 

B = b + 2b′          (2.65) 

B = 0,57 + 2 × 0,97 

B = 2,536 m 

12. Koefisien Strickler (k) ditentukan melalui Tabel 2.23. 

Tabel 2.23 Harga Koefisien Kekasaran Strickler (k) 

Q 

(m3/s) 

k 

(m1/3/s) 

Q > 10 45,0 

5 < Q < 10 42,5 

1 < Q < 5 40,0 

Q < 1 dan Saluran Tersier 35,0 

(Sumber: Standar Perencanaan Irigasi KP-03) 

13. Kemiringan saluran, dihitung dengan persamaan (2.66): 

I=
V

k×R
2

3⁄
           (2.66) 

I=
0,35

35×0,302
2

3⁄
 

I= 0,00049 

dimana :  I  = kemiringan saluran (%) 

   V = kecepatan aliran (m/s) 

   k  = koefisien kekasaran Strickler (m1/3/s) 

   R = jari-jari hidraulik (m) 

 
Gambar 2.12 Dimensi Saluran Induk

 

 


